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AITIOAOIKH EKGEZH: UNITY

YrevBupion: Autol oL xapteg mopeiog Ba emtpéPouv TNV KOAUTEPN KATAVONON TNG PONG epyaciag
™¢ napaywyns YndlakolL SLadpacTikol MEPLEXOUEVOU HECW TIPAKTIKWY CUCTACEWV Kal
HOPTUPLWV ETTOYYEALATIWV. Me auTOV TOV TPOTO, OKOTEVOU LLE VO UTTOOTNPLEOUIE TOUG HABNTEC
KoL TOUC Sa0KAAOUG OTLG LABELEG TOUG, AAAQ KaL PETA TNV eKAiSeuaon, OTNV MPAKTLKI TOUG

enayyeApatikn {wn.

1. IXETKA UE TRV TEXVOAOYia

H texvoloyla mtou
Xpnotpomnoteitat

ELKOVLKN TTPOayHOTIKOTNTA

TeAlkdg 0TOXO0G
KOlL AMOTEAECOL

Anpioupyia evog Baaowkou 3D PndLlakol KOGUOU LE TO AOYLOULKO
Unity.

O «kOOopoG» Ba amoteAeital and Yo yn HE LEPLKA OTOLXELD YUPW.
Ta otolyeia eivat avrikelpeva mayvidlol Omwe MAOVATES yUpw,
aotpovalTng, SLOOTNUKOG TTUPAUAOG...

InUavtiki onueiwon: Auto To £pyo ival Slabéotpo pévo os
Android pe akouoTIKA xapTtoviou google.

tablet, tnAédwvo)

MNeplypadn Tou To VR eival évag ouvduaopog 3 otolxeiwv: aAAnAemiSpaon,

epyaAeiou eupantion kot Yndlakog kéopog. Mmnopel va xpnolpononBel yia
Tuxepa matyvidia, Blopnyxavia, ekmaibsuon, vyeia.

Méaoo mou To VR pmopel va avTIPUETWIILOTEL o€ KIvNTO ThAédwvo Xapn os

XpNOLUOTIOLELTOL 0KOUOTLKG TNAEDWVOU 1 e l8IKA akouoTIKAd VR (086vn pe

(urtohoylotng, kebaAr f urtoloylotn)

To VR &nuoupyia va avalnmiotei os tnAépwva xapn os
O0KOUOTLKA SLdou 1 pe ta akouoTka VR (pe peAnAn r xpnon)

Mou Ba sivatl
npooBaactuo
(epappoyn,

mAatdopua,
LOTOTOTOC...)

Otav avantuooete €va €pyo VR, mpénel va €xete umtoyn oag mou
Ba eival Stabéopo: otov umoAoyloth; Ba sival pa epoppoyn; Eav
val o Tolo tThAédwvo, Android 1 i0S; 2 akouotika VR; Mota
akouotikad VR; Mdoo elval va untdpyet SLabgotun pa ebapuoyn o
KOTOOT AT EGAPLOYWV...

TNV mepimtworn) pag, £XoU e oXeSLAOEL TO £pYO £T0L WOTE va elval
npooBacipo oto Google Card Board (8ev xpelaletal va
enevOUOETE TEPAOTLO KOOTOG) Kal Lovo o€ Android.
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O Aoyog eival otL 6ev BEAaE va SNULOUPYICOULE Lo
KATAAANAN edappoyr) ENeLdN analtel meplocoTEPO XPOVO
epyoaoiag Kot xprjpota.

Z€ YEVIKEG YPAMUEC, oL edappoyEG VR Kkat Ta matyvidia

pmopoUv va AndBouv amo - kataotipata epappoywy (Omwe

To Google Store, to Apple Store)

- TO KATAOTNUA TWV AKOUOTIKWY (0mwc to Oculus)

- Stadlktuaka kataotipata (6nwg to STEAM)

Y€ YEVIKEC YAWOOEG, XpnolpomoloUpeva VR Kal Ta motyvidia mou
TPETEL VA KAVW OO - KataBgote TNV elkova (oto Google Store, oto
Apple Store)

- TO TIPOYPALUA TWV 0KOUOTLKWV (StartiBetat oto Oculus)

- TeEXVIKA pooPaon katadikaopuévn (oxedov to STEAM)

Mooog xpovog H avamtuén tou VR eival xpovoBopa Kol amottel oplopEveg
XPELAOTNKE yLOL TNV TEXVIKEC YyVWoel. Oocov adopd to Xpodvo, Ba eaptnBei
avantuén autou TIPAYHOTIKA OO TOV TEAIKO OTOXO TOU £pyou KoL TNV
Tou gpyaleiou; TLOAUTIAOKOTNTA TOU.

Mo UTO TO £PYO XPNOLUOTIOLCOUE LA LNXOLVE) TTALXVLOLWY TToU
ovopaletal Unity kat €goupe avamntuéel Eva £pyo TIOU omaltel
ToAU Alya BrApata kwdikomoinong.

AuTO To €pyo unopel va avamapayBel oe 15 Aemtd, aAAG
QALTEL KATIOLEG YVWOELG yLa To Unity.

Ooov adopad Ta frupata:
- AN kat Snuoupyia Aoyaplacpou evotnta
10 Aemta
-‘Epguva tou akpLBoug nakétou Google VR kat Anyn
10 Aemta
-‘EpEUVA TWV TIPOKATAOKEVAGUEVWY, TWV OTOLXELWVY KOL TWV
avTtikeEemEvwy Kot Aqgn
30 Aenta
- Katavonon twv Baocikwy OTOXELWV TNG EVOTNTOG - BACLKEC
Spadsa Rdwamgahdipending on your level with 3D software
- PUBuLON TG OKNVAG
50 Aemtd
- Aoklpalel kot SLopBwVEL TN KNV 00¢
25 Aemta
- Tevika@, n avamapaywyr tou epyaleiov dtapkel amd 10 Aemtd £Wg
1,5 wpa avaAoya e To MTOCO AVETN £lval n povtehomoinon
3D, 0 XelPLOKOG AOYLOULKOU 3D Kol TO TEXVIKO epyaAEio.
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2. XpnoLUOTOLNUEVO AOYIGULKO

‘Ovopa Tou AoyLlopkoU | MNa auTo To €pyo, XPNOLUOTOLCAUE TN pnxovr moxvidiwv UNITY kat n
€kdoaon mou xpnotuomnoleital eivatl to Unity 2019.3.15f1

To Unity sivat pua pnxovr moyvidtwyv moAAamAwy nAathopUwy Tou
XPNOLOTIOLELTAL YLO TNV avamTuén (LeTaty aAAwV) eumeplwyv VR

Ovopa TG eTatpeiog Unity Technologies (ula etatpeio avamtuéng AoyLopikol moyvisLwyv
pe €6pa Tig HMA)

Kataotaon' H Unity o€BeTat Ta SIKALWLOTA TIVEUHATIKAC BLOKTNOLOE TwV GAWV
TIVEUULATLKWV ] , ) ) )

KW LATWV KOl AVAUEVEL QO TOUC XPHOTEG TNE VO KAVOUV TO (610.

(cc, 1blokTnTo

oloTNHO, K.ATL) AmntoteAel moAttikn NG Unity, og KATAAANAEG TTEPLOTACELC KOL KATA TNV

Kplon tng, va amnevepyorolel fj / Kat vo teppatilel Tov AoyopLlacpo f thv
poaoBaacn XpNoTwy ou mapaBLalouv eMavelAnUUEVa i} KAThyopouvTal

emavelAnUuéva yla mopaBioon Twv MVEUUATIKWY SIKALWUATWY A GA WY

SIKALWHUATWY TIVEUUATIKNG LOLOKTNOLOG AAAWV.

Y€ Mepinmtwon mou £XETE XPNOLLOTOLOEL ETITAEOV TTOPOUC VLA TO TEPLEXOUEVO TOU gpyaleiou oag, meplypate
TOUC MOPAKATW:
Ma va SNULoUPYAOETE ELKOVLKOUC KOGHOUG 1) €va €pyo VR yeVvIKA pmopeite eite vo oxedLAoETE
Kol va dnuloupynoete ta SIKA oag oTtolyeia, xpnowlomnolwvrag epyaleia 3D Modeling
Umopeite vo e€0LKOVOUNOETE XpOVO KOL VO ELOAYAYETE OPLOUEVA OTOLXELQ TTOU €XOUV 6N
dnuoupynBei and aloug.
AuTa ta umtapyovta ototxeia ovopdlovtat MEPIEXOMENA ) MPOKATAPKTIKA
‘Eva otolxeio pmopetl va givatl pio udn, éva 8Evtpo, Evag Nxog, £va KTipLo ... oTiénmote OéAete
VaL ELOAYAYETE OTO £pY0 0aC. Ta MEPLOUOLOKA OTOLXELa pmopoUV va gival og 2D f og 3D,
£€apTATAL TPAYUATLKA OO TLG AVAYKEG GO,
Mmopeite va katefdoete autd ta otolyeia Swpeav ) Pnmopeite eniong va ayopAceTe
TLEPLOUCLAKA OTOLXEla €AV XPELATEOTE TTOAU CUYKEKPLUEVA OTOLXELQL.
AkoAouBouv oplopévol mopol 6mou Umnopeite va Bpelte otolxeia:

- To Unity asset Store ival pépog tou Aoylopikou Unity kot mpoodépet pia LBALOBRAKN oToLXElwY TTou

pmnopel va swoayBel aneubeiag amno tn Stemadn Unity.
- To https://poly.google.com/ givat pio BuBALOOAKN avTikelpévwy 3D
va IPowBr couV TOUC TPOYPAUMATIOTEG VR Kal AR yLa va LoLpaoTouV TLG

dnuioupyieg Toug

- https://free3d.com/ 6mou pmnopeite va Bpeite moAAd 3D povtéda Swpedv

- To https://kenney.nl/ givat pa adsla Snpodclou topéa Omou Ynopeite va katefaoete

KLT TIOU TIEPLEXOUV
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- https://itch.io/game-assets/top-sellers/free/tag-3d eival £vag LotdTomMOC TOU emLTpEnel aveApTtnTOU
dnuoupyol Buwteomayvidiwy yia tn drhoevia, Tn Stavopn Kot TNV mTwAnon Twv
TALLXVLO LWV TOUG.

EmumA€ov, o Lototomnog npoteivel Swpeav BLBAL0ONKN otoeiwv pe adela Creative
Commons
Yriapyouv moAAol Lototormol kat BLBALoBRKEC Tou MpoodEPOUV IEPLOUCLOKA OTOLXELD, mock-up
1 TPLodldotata HovTEAD SwPEAV, TO LOVO TOU XPELAleoTE elval va Bpeite auto mou
oaloBaveote aveta kot omou Ba Bpeite OAa Ta oTolyela mov XPELAlECTE.

3. Kootog

Kootog dnuloupyiog Ma auto to €pyo, Sev umrpxe Kapio Samavn.

0UTOU Tou gpyaleiou | Mpaypatt, £{OUUE XPNOLLOTIOW|OEL SWPEAV TIEPLOUGLAKA

otoleia Kal tn Swpeav €kdoan tou Unity.

Avaloya HE To £py0 0ag, EVOEXETAL VA XPELAOTEL va AyopAOETE

£va akouoTiko VR (autovopo ) akouoTtikd VR Baoel urtohoylotn)
Tou propet va eivat akptPo.

Qotooo, untapyel tavta n duvatdtnta va £xete «hOnvA» £kdoon tou
VR He Ta akouoTikd tou Google Card Board

'H, Téhog, avamntulte €va €pyo mou Baciletal oto WEB VR to omnoio
gival VR mpooBacipo os onolodnmote €i60¢ mpoypapatog

neptiynong oto Web
MevVIKO TTPOYpOA Avaloya e TNV TOAUTIAOKOTNTO TOU £pYOU, OMALTOUVTOL TIOPOL
TlpoAdynong TANPWHIG A UTOOTAPLEN

Y€ MepinmTwon Mo £XETE XPNOLLOTOLNCEL EMUTAEOV TTOPOUC VLA TO TTEPLEXOUEVO TOU EpYaAEiov
o0¢, avadEPeTe AEMTOUEPWE TO KOOTOG TOUC MAPOKATW:

To AOYLOMLKO glval SwpPeAV, EKTOG EAV OYOPAOETE EMUTAEOV OTOLXELA OTIWG AUTO TIOU UTopE(TE
va katePaoete oto Unity Asset Store.
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4. Bruata nopaywyns

Neplypalte kdBe BAua tnG Mapaywyng Tng ddong
oxeblaong tou epyaieiou

Marti dnpoupynoate Z€ QUTO TO £pyo, BéAape va deifoupe otL eival Suvato va
QUTO TO epyaAeio; ouvbduaotel n povtedonoinon VR 3D e OpLOUEVEC OXOALKEG
Taéelg, onote anodaciocape va To XpNOLUOTIOL)COULE YLO TV
Erotrpn Kat eL61ka yio to HALako Zuotnua.

Me autnv tv edpappoyn VR, evtonicape Evav actpovautn
o€ £vav MAQVNTN Kal To UTTOAOLUTO NALOKO cUotnua eival
opaTto.

Oa umopovoate va MPpoadLlopIlOETE G TTOLOV MAQVTH €lval
0 aotpovauTng;

H dnuioupyla plag té€tolog oknvng ival évag tpomog va
BuBloete TOUG XPNOTEGC OTOV KOOHO TNG ELKOVLKAG
TIPAYUATIKOTNTOG KoL va eETULTPEYETE ToV PnPpLaKO XELPLOUO
Baaolkwv otolyeiwv: To NALaKO pog cvotnua!

TL Aewtoupyleg éxey; Mo auto to €pyo, KaBwg BEAaE Vo TO KPATHOOUUE amAo, N
puovn Suvatotnta eivat va efepeuvriooupe Tto HALOKO
Juotnua pe 0pOa aANG TtepLoTPEPOEVN OMTIKA YwViaL.

H aAAnAenidpaon pe otolxeia Ba anattovoe Bripota
kwdLkomoinong mou Ba Tav oAU Bapu yla Eva TPWTo
oEMLVAPLO.

g 7eVIKEG YpaupES, | Evotnta £yl og oAy peydro
e0pog Aettovpyldv. H mpocsHBnkn nyov, eikdvov,
KWWNOEWV, OAANAETIOPACEWMV, EIOIKOV EQE Elval TA
Bacwd otoryeio Tv Asttovpyidv Unity.

Molog Ba eival o okomog Tou; AuTO T0 £pyo adopd To HALaKO TUoThua Kal
(madaywyikn, emikowvwvia, ooxoleitol pe mpoomtikn, péyebocg Kal otolyeia.
maLyvidlo K.AT)
Mevikd, Ta épya Mou pmopouv vo avamntuxBouv oto Unity
umopel va €xouv moAAamAoug okomoUG: amo tnv ekmaibeuon
£w¢ TNV Puxaywyia i okdun Kot os uPnAotepn Babuida
Bapld Bopnyavia i okomou¢ Blopnxaviog uyeiag
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5. ®don dnuioupyiag

MapakaAw OVOUAOTE KoL TeEpLlypaTe Mapakatw ta Siddopa Bripata tng dnuoupyiag tou epyoaieiov (eAdxioto
5)

Katdoteto | lNa va katepdoste to Unity og mdpe oto

Unity Katdotnua Unity3D -> https://

Ko unity3d.com/get-unity/download Mdpte to

Snuoupync | Swpedv MPOOWTILKO TAKETO

TE évav

Aoyaplaopd | o e o e

Plans and pricing

We offer a range of plans for all industries and levels of expertise
All plans are royalty-free

Individual l
Student Personal
Learn the tools and workflows professionals use Start creating with the free version of Unity
onthe job Learn Premium
Master Unity with expert-led live sessions
Free Free and on-demand learning
m i

Eligiblliy. Included with Plus, Pro and Enterprise plans
Revenue or fun

‘Ocov adopad to péyebog oto dioko:

Y10 6loko pou n evotnta sivat 8,16 GO
ErutA£ov, XpeldleoTe eMionNg XWPO yLa TO £py0
ooc (elkoveg, Bivteo, nyot, otolxelia...)

Npwtn Otav yivel AN tou Unity kat dnpoupynBel o Aoyaplacpog cag, Oa petafeite
oelida otnV apxLkn oeAiba.
OAa ta épya oag Unity Ba eyypadolv og autnyv tn oeAiba.

e
Qunity L ]

3 Proects Projects Ao R

& Community

= installs

9

You have no project here.

dimpaproject.el
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Anpoupynote - Awote éva Gvopa oTo £pYo 0ag
£va véo oxESLo Ba dnuoupynoet éva GAKEAO E TO £pYO 0AG OE AUTO Kall
TO (610 6vopa. - AToBNKEVOTE TO OTOU €XEL VONUA YLa E0GG.

JupBouléc: To kaAUTepo eival va Snuloupynaoete évav el6Lk6 dpakeho Unity.
Oa oag SLEUKOAUVEL va €XETE LA ypHYOpPN ETILOKOTNGN O OAOL TA £pyal
gvOTNTAG
- EmuAé€te 3D - pnv avnouyeite otL pnopeite va aldete 2D oe 3D katd tn
Slapkela ¢ Snpoupylag

— -
€ Create a new project with Unity 20193.151 - u] x

DIMPA - VR

“

! g 0

C:\Users\laeti

Katd th dnuloupylia evog véou £pyou oto Unity, Ba Snpoupynost éva apyeio
oToV UTtoAoyLoTr oag (Omou £xeTe emIAEEEL TO £pyo oag yLo amoBnkeuon)
AUTO TO apyxeio Ba TEPLEXEL TAL TTAVTA YL TO £PYO OAC, CUYKEKPLUEVA TO
daxelo Asset O dpakelog Asset elval amapaitntog, pnv tov dtaypdPete moté
ylati mepLEXEL TO TTAVTO VLo TO £PY0 OAG: NXOG, ELKOVEC, UDEG, oevapla

H diaypadn touv pakélou ototyeiwv Ba tooduvapovos
ME T Staypadn Tou £€pyou oag.
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Digital Innovative Media Publishing for All

ZHMANTIKEZ Mpwv Eekivrioete pe tn daon dnuloupyilog, OpLOUEVES BAOLKEG

AAHPO®OPIEX | mAnpodopieg yia to Unity:

A TO VR KAI

THN ENQZH Ac pifoupe pa patid otn diemadn tng UNITY kat otig Stadopeg
KOPTEAEG:
Kaptéha Zknvn: elval To onpeio 6mou dnULOUPYELTE Kal TPOTIOMOLEITE Ta
oTolEla
Kaptéha matyvidloU: eivat auto mou BAETOUV OL KAUEPEG
Kaptéha £pyou: 6mou amobnkevovtal OAO TA OTOLXELO 0OC - QUTA Elval Ta
otolxeia mou Ba TomoBEeTOETE OTN OKNVH COG
H kovooAa adopd to uivupa opAALOToS Kot TiG TAnpodopieg
Tab Inspector: oag 6ivel OAeg Tig Aemtopépeleg (BEan, uéyebog, KAlpaka,
XPWUO, EOE, CUOTATLKA...) OXETIKA JLE TO AVTIKELLEVO TIOU EXETE ETUAEEEL OTN
oKNVA 00g
Eav kavete KAk oto PLAY Ba deite TL BAEMEL N KAUEPA

If you modify positions, elements or objects while being on PLAY nothing
will be saved.
< [—p—- dimpaproject.el
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MepIKEC CUVTOUEVOELG MANKTPOAOYioU:

Kavte 8el KALK 0TN OKNVI 00¢ KaL KPOTOTE TATNUEVO TO -> Ba €xete Alyo
MATL Kal Ba pmopeite va deite katl va eplnynBeite otn oknvr oag

E -> Xx€pL: umopeite va PETAKLVAOETE TNV amoyr) oag otn oknvn xwpic va
UETAKLVOETE OTOLXELQ.

W-> 00lC ETUTPETIEL VAL LETOKIVHOETE T OVTLKELEVA TTOU €XETE eTUAEEEL €lte
oTov afova x, otov dgova y ) atov afova z

E-> 00¢ EMUTPEMEL VO TIEPLOTPEPETE TA AVTIKELHEVA

R-> yLa KALLAKWON TWV QVTIKELUEVWV

T-> punopeite va SLopBWOETE TO AVTLKEILEVO

Y-> oag divel meplotpodn, KALLAKO Kal Kivnon Tautoxpova

DuoLKa, UTIAPXOUV TTOANEG TIEPLOCOTEPEG CUVTOUEVTELG KOL TIOAANEG OKOUN
Aettoupyieg oto Unity, auTtég elval Lovo ol BaoLKEG.

Kdarowo Ae§IAOyL0:

Tt eivai To makéro;

Ta naketa eivat ouAAoyEc apyeiwv kot Sedouvwy armd Epya Unity n
otolyeia Epywyv, Ta omoia ouuriEfovtral kot anodnkevovtal o€ Eva apxelo,
apopolo ue ta apyeia Zip. Mmropei va givat pia cuAdoyn nnyaiov kwdiko
UE TIPOYPALLATO TTOU UTTOPEITE VA ELOAYAYETE KaL va EEQYAYETE OTN OKNVA
00G. J0G ETUTPETEL va MAPAAEPETE kKamola pdon kwdLkomoinong kot va
XPNOLOTIOLNOETE NON AVENMTUYUEVX OTOLXE(X.

Tt gival Eva mEPLOUOLAKO OTOLXE(O;

Eva otoyeio eival pula avanapaotaon onoloudnmote oToLXEIOU TTOU UTTOPEL va
xpnotuormownBei ato matyvidi rj To Epyo oag.

Eva otolyeio umopel va mpoépyetal amo eva apyeio mou dSnuLoupynnke eKTog
tou Unity (yla napadetyua eva nakeéto) onws povtéda 3D, apyeio rxou,
ELKOVQ, UPEC 1 0moLoVONTTOTE atd Tou¢ dAAoUG TUTTOUC apxEiwVY Tou
urnootnpilet to Unity

Optouocg amo tn pon epyagiac Unity Asset

https://docs.unity3d.com/560/Documentation/Manual/AssetWorkflow.html#:

T eival éva mpoyepo

Eva mpdoyelpo onuaivel mpo-KATAOKEUAOUEVO. ZnUAiVEL OTL gival Eva nén
KOTQOKEUQIOUEVO QVTIKELUEVO TTOU €lvail ETOLUO yLa xprion. Kamotog umopei va
OXe6LA0EL TO SLKO TOU NTPOKATOOKEUAOUEVO QVTIKE(LEVO TTALYVIOIOU KAl VO
SLOUOPPWOEL, VO TO AmOINKEUTEL UE OAQ TO CUCTATIKA TOU, VO QTTOUEVOUV
TIUEC LOLOTATWV.
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PYOMIZTE Mo va gival cupBatd outod to £pyo pe to Google Cardboard, mpémnet va
TH ZKHNH oAAa€oupe oplopEveg pubpuioslc:
IAZ: File -> Build Settings -> Select ANDROID and click SWITCH PLATFORM
[ €2 Rotation - SampleScene - PC. Mac & Linux Standalone - Unvty 201931511 Personal <DX11> - o X

File Eoit Assets GameObject Component Window Heip

ewscwe  cun ] 3
-

Open Scene o .

@ Game.
Sove Cules. Display 1+ Free Aspact
Save As Cutesniftes
New Project..
Open Project.
Save Project
Build Settings..  CirteShiftsB
Build And Run cuneB

Bt

‘Emetta PLAYER SETTINGS -> go to XR SETTINGS

-> tick VIRTUAL REALITY SUPPORTED

Player )
° + 1A
pros—

» Resoiution s Presantation
> Splshtnage

+ tber ettings

+ Puishing Settngs

30 Settings.

ARCors Suppored.

ated Sertings
Vi Reaity Suppored al
il Reaity SDKs

UstisEmpry

P ———

Sterea Rendering Made® M pass. - !

click + to ADD Cardboard

-> tick VIRTUAL REALITY SUPPORTED
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[l Earth Rotation - SampleScene - Android - Urity 2019.3.1511 Personal <DX115
Flle Edil Assets GameDbject Component GoogleWR Window Heip

Baild Settings D

O Taper ici pour rechercher

click + to ADD Cardboard

e Lo va propeite va Bpeite to €pyo oag oTo ThAEDWVO oag, TPETEL
VO TO OVOUAOETE 0WOTA oTIC PYOMIZEIZ NAIKTQN

Y€ 0UTO TO £pyo £xoupe al el To dvopa tng etalpeiog: SolarSystem kot
ovopa poiovtog: GCB (yia to Google Cardboard)

Build Settings - o L

BeBatwBeite 6t oe AANEI PYOMIZEIZ OTL N avoyvwpLon TOU OVOUATOG TOU
TIAKETOU 00G £XEL KwdLkomownBel cwotd:
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Player
Auto Graphics API
Graphics APls.
= Vulkan
= DpenGLES3

Require ES3.1
Require ES3.1+AEP
Require ES3.2
Color Gamut*

= sRGB

Multithreaded Rendering*

Static Batching

Dynamic Batching

Compute Skinning®

Graphics Jobs (Experimental)

Lightmap Encoding

Lightmap Streaming Enabled
Streaming Priority

Enable Frame Timing Stats

Vulkan Settings
SRGB Write Mode*
Number of swapchain buffers

Identification
Package Name
Version*

Bundle Version Code
Minimum A1 Level
Target APl Level

Configuration
Scripting Backend

Api Compatibility Leval*
C++ Compiler Configuration
Use incremental GC

v

v

v

Low Quality
2

0

3

com.SolarSystem.GCB

0.1

1

Android 4.4 'KitKat' (APIlevel 18)
Automatic (highest installed)

Mono
NET Standard 2.0
Release

PEx,

Btﬁl

Mute Other Audio Sources®

e  Minimum API Level

Your API Level must be 19

v w1 s

Identification

Package Name com.SolarSystem.GCB

Version® 0.1

Bundle Version Code 1

Minimum API Level Android 4.4 ‘KitKat (AP level 19) .
Target AP| Level Automatic (highest installed) .

Scripting Backend Mono -
Api Compatibility Level® NET Standard 2.0 -
Cs + Compiler Configuration Release

Use incremental GC

Mute Other Audio Sources®

Twpa Aot oL pubpioelg elval £ToLoL KOl UITOpOUE VO 0pXLCOULLE VO SNULOUPYQULE TO
€pyo pag

Mo auTo To £pyo BEAOUE VO TIEPLOTPEPOULE LD KALLEPA, WOTE VA
propoU e va dole tn oknvry o€ 3DoF

Eloaywv

o va To KAVOULLE aUTO XWPLig KwdLKomoinon, PEMEL Val ELGAYAYOUHE Eval
TLaKETO Tov ovopdletal Google VR for Unity: GVR SDK for Unity v1.200.1
Download the package -> https://github.com/googlevr/gvr-unity-
sdk/releases/tag/v1.200.1
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https://github.com/googlevr/gvr-unity-sdk/releases/tag/v1.200.1
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J€ TLYPNOWEVEL AUTO TO TIOKETO;

Oa smutpéP el Tov EAeyyo TG KApEPAC He TteploTpodr] 360 °.

AuTO To TaKETO emLTpéTel emiong, Reticle Pointer, Event Trigger kot
TIOANG GAAQL.

GVR SDK for Unity v1.200.1 (2019-07-17)

Breaking changes

¢ Removed all instances of deprecated GuILayer component from the Main Camera in all sample scenes,
for compatibility with Unity 20193

Deprecations
« Dropped support for Unity 2018.1 due to lack of Java8 support and the Google VR SDK for Android now
requiring it. 2017.4 LTS is still supported
Bug fixes

o Fixed Unity 2019.3 build error "More than one file was found with OS independent path 'lib/armeabi-
v7a/libgvr_audio so

v Assets 4

@ GoogleVRForlnity_1.200.1 3 M8
@ GoogleVRForUnity 12001 sourcezip
D) Source code (zip)

[D Source code (tar.gz

Eloayayete T0 MOKETO 0 OTN OKNVA 0OC:
Click on Assets -> Import Package -> Custom Package -> Select the package
GVR (mine was in the download)

104 - Somlescene - Androd - Uniy 201931511 o
Fie Gt Asets| GameOvject Companent Gosglel

>

Select Dependencies
Retresh
Reirm

Reimport All
Extract From Prefab

Update UsElements Schema

P Taper ici pour rechercher
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.3
WAKETH  <plaflg cospmomseis @) LES APPRIMEURS o2

Berulsirdarungsinstng GO LogoPsyCom,

The #DIMPAproject has been funded with support from the European Commission. Its content and material reflect the views only of the authors, and the Commission cannot be
held responsible for any use which may be made of the information contained therein. Project code: 2018-1-FR01-KA202-048220




#DIMPAproject

MIPA projec

Digital Innovative Media Publishing for All

s - o x
Adfichage ]
» Telechargements > v © | 2 Rechercher dans: Telécharge.
Nom Modifié le Type Taille

~ Avjourdhui (1)

¥ GoogleVRForUnity_1.200.1 04-06-20 10:28 Unity package file 33784 Ko
~ Hier (4)
1 archive Dossier compressé 1o
[ eant_ballmtl Fichier MTL 1Ko
earth_ball 3D Object 85Ko
%] eartn_ball 03-06-20 19:27 Fichier PG 817K

EruAé€te Import

' Import Unity Package
®

Twpa pmnopeite va deite 1o makéto oag Google VR BplokeTal oto pdkeho Asset.

- Earth Rotation - SampleScene - Android - Unity 2019.3.15f1 Personal <DX11>
File Edit Assets GameObject Component GoogleVR Window Help

- Erasmus+
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Ag Ag elodyouple évav KUBO Kot va Tov HeTtatpéPouE oE yn
Snuoupyrio
OUI,IE 10 1..5-:«-m.¢-mm-g.umw,mh - 8 x
€dadog!
o Vo TPOTIOMOLOETE TOV KUBO, UIMOPELTE VA ELOOYAYETE OPLOPEVEC TUUEC
oto INSPECTOR TAB 1] UTTOPELTE VO TO TPOTIOTOLOETE HE TLG EVIOAEG
Bl €2t Rotation - SampleScene - Android - Unity 20193151 Personal* <OX11> - o x
- Erasmus+ dimpaproject.eu
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Bl cartn Rotation - SampieScene - Android - Unity 201931511 Personal* <DX11>
File Edit Assets GameObject Component GoogleVR Window Help.

Mo va petovopdoete éva avtikeipevo -> INSPECTOR kat va to
HETOVOUAOETE. EXW HETOVOUAOEL Tov KUBo GROUND

- Erasmus+
(24
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EIZATQrETE TA
ANTIKEIMENA
TOY
NAIXNIAIOY
2TH IH MA2

Mo auto to £pyo BéNoupe va sloaydyou e Sladopa avtlkeipeva: Evoy

ootpovaltn Kol HEPLKOUC TTAQVATEG.

MriopoUpe eite va ta Snuoupynooups eite va Ta
KateBacoupe n6n oxedlaopéva. O LotdTomnog ard tov onoio Oa
npayyotonotjoouue AAPn Ttwv otoleiwv pag eivat POLY
GOOGLE: https://poly.google.com/

Na Bupdote mavra tv AdsLa.

J€ YEVIKEG YPOAUUEG, ETUAEETE TIEPLOUCLOKA OTOLXELQ TIOU €lval

SnNuocLou TopEa

Eav xpelaleote kamoleg mAnpodopieg oxetika pe to Creative Commons
KoL To License, uTapxeL pLa eL6LKA TAEN yla autd oe autd to MOOC

SNULOUPYLKA, XWPLG SIKaLWHATO EKUETAAAEVONG I} AKOUN Kol AdsLa

Koatd t™h Afyn evag otoixeiov 3D nipénel va emiAéete th popdn OBJ

Ag kateBaocoupe éva ASTRONAUTE
Oplote 0 oUvSeopog: https://poly.google.com/view/

Q astronaute

@ Like < share & Download I Create GIF
&, Original gITF File
Astronaut 270likes 23

&, original OBJ File

‘ Poly by Google
&, Updated gITF File

| #space #solarsvstem #exnl

- Erasmus+
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Oct 22,2017 People & Characters  Uploaded 3D Model
Public / Remixable (CC-BY)

Remix this content
This content is published under a CC-BY license. You're free to use this as long as you

credit the author. Learn more

Download

This content is published under a CC-BY license. Author must be credited. Learn more

CANCEL DOWNLOAD

Mo Vo ELOAYAYETE TO AVTLKELEVO TTALXVISLOU 0T XWPo 0OC:
1. Anpoupynote éva pakeho
oto Asset 00 TO €Xw
ovoudosl Character

2. Ewoayayete To oTolXEio oag

[ GC8 - SampleScene - PC, Mac & Linux Standalone - Unity 2019.3.15¢1 Personal® <DX11>

Altacatec

Update UlElements Schema

Open C# Project

P Taper ici pour rechercher

3. EmAE€te To apyeio mou BEAETE KoL ELOOYAYETE TO
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Jements

CHAHIN_EARTH.mt! 1106
@] CHAHIN_EARTH 11-06-20 1545
1 archive (8) 11-06
I archive (7) 11-06-20 1545
f. model_obj_b-y9HDTsu7q_8PfawgLGgid n
I archive (6) 11-06
i archive (5) "
1 archive @) 110620 154

i archive 3) 11-06
i archive ) 11-06 Dos:

| Astronautmti 11-06-20 15:32 Fichier MTL
&) Astronaut BaseColor 11-06-20 1532 Fichier PNG 2061 Ko
@) Astronaut 11-06-20 1532 3D Object 189 Ko
1 archive (1) 11-06-20 153 D ! s

RocketShin 1302 mt 11-06.20 15 Fichier MTI

4. Itn ouvéxela, petapeite oto pakelo Asset mou ovopdleton
Astronaut ko cUpEeTe 10 oToLXEio oTo £80aog

Zvpmépaopa: O aotpovavtng oag eivat edw!
[ai§te pe avtd kat Tomobetrote Tov ekel mov Bélete, oe 3D Sev ypedletat
va avnovyeite ya tn fapvtnta

[ GCB - SampleScene - PC, Mac & Linux Standalone - Unity 2019.3.15f1 Personal* <DX11>
File Edit Assets GameObject Component GoogleVR Window Help

2 - BIEEEEI > [ ]

-.suml
Display 1 ~ Free Aspect ~ Scale 8 1x

>
€
>4

+v a » e x #s

- Erasmus+ dimpaproject.el
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PYOMIZTE Ma va pubpicoupe thv Kapepa Oa XPNGLULOTOLCOUHE TO TtakéTo GVR.
THN In the Google VR package select -> folder Prefabs -> GvrEditor

KAMEPA :AX Emulator XUpeté to otnv Ltepapyia / oknvi

B8 68 - Samplescene - PC. Mac & Linux Standalone - Unity 2019.3.15t1 Personal* <OX11> - o

- C ~_Scale O— 1 ‘ GwrEditorEmulator (Prefab Asset)
v € SampleScene®
| ] @ O
) Main Camera
) Diroctional Light
@ Aswonaut
Ground

Open Prafab

1 open Pretan for fu eating suppon

Rootin Prefab Asset

' GurEditorEmulator q

~ Tag Untagged ~  Layer Default

v Transtorm °
Position X0 Yo z-2
Rotation X0 Yo 20
Scale X ¥ z

¥ ¢~ GvrEditor Emulator (Script) o
Scopt GvEditorEmulator
Camera

Controls:
«Alt + Move Mouse = Change Yaw/Pitch
+Ctrl + Move Mouse = Change Roll

+of

o & hssets > GoogleVR > Prefabs > Add Component

W Scenes. ’
e bbb i
* W Shaders

&, Iummmu-mm.wm

- ——@®— | AssetLabeis

Yag Sivel Tov éAeyyo TNG KAPEPOC.

ZHMANTIKO NAHPO®OPIEZ: Eav natfoete PLAY kot KAvete Alt + LETAKLVAOTE|TO
movtiki (aplotepd kot Se€Ld) ko Ctrl + petakiwviote To movtikt Oa pnopeite va
HLETAKLVAOETE TNV KAREPA O AELTOUpYia avarapaywyrg. OQuunbeite va Byeite
navta ano tn Asttoupyia avanapaywync.

To nmpdPAnua eivat OTav XTUTIAUE TO TTaXVidL, N KApepa Sev BplokeTal og KOAR
tonoBeoia - mnyalvel oto KEVTPo Kal §gv Umopoupe va SoU e Ta Tavta

Ma va AUooupe auto to {ATtnua Ba: eLodyoupe Eva MPOYpaa
aVamopaywyns (Katavonote éva KEVO avTIKELEVO TTou Ba ival Ta PLATLO LOG)
Na to npdgouv

Elcaywyn KEVOU QVTIKELLEVOU
Click Right on Hierarchy tab -> Create Empty

- Erasmus+ dimpaproject.eu
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B3 GCB - SampleScene - PC, Mac & Linux Standalone - Unity 2019.3.151 Personal* <DX11>

t Ste ‘on Game
SO R ‘k\ S gy CvEdtorEmutor

! Open Prafab for full edit|

Root in Prefab Asset

| GurEditorEmulay
Tag Untagged

Copy
Paste
Rename
Duplicate
Delete

B Project *
+~ Create Empty. a
+ i Models 0 Okect ? JoogleVR > Prefabs >
20 Object )
» iu Prefabs
W Scenes Effects 2 ’
Y I mEEEbN
» m Shaders. Audio 4
::.sr Video > Controser  EventSyst..  Headset InstantPrev.. Keyboard  GviEGHors.
i >

Exw petovopdoel To "kevo avtikeipevo" PLAYER (deite tnv kaptéAa emBewpntn

Kat petd oclpete tn dwroypadikn pnxav HEco o€ auTtd To ASELO TPOYPAUA
ovamnopaywyne: BeBalwBeite 6TL N KAEPA KAL TO TTPOYPALUO OVATIOPAYWYNS

é‘ouv TNV da Béon:
Cconan |l & § Account ~ | Layers v i Layout  * Scatsb - § & | Account = Layers - Layout =
© inspector @ Inspector

@ < Main Camers Static » a < Player Static v
" Tag MsinCamera = Layer Defoult -  Tag Untagged ~  Layer Defaurt -
v A Transtorm ® @ 1| v Transfom o=
Postion Xo ¥ 2o Positian X0 Y1 zo
Rotaton X0 ¥o Zo Rotation X0 Yo zo
Scale X1 ¥ z Scale X1 X1 z1
¥ ™ - Camers CEN e
Creur Fiags Skybox .
Background I
Custing Mas: Everything -
Projection Perspective
FOV Axis verical
80
Physical Camera
Chpping Planes. Near 0.3
Far 1000
Viewpon Rect X0 Yo
W H
Deptn. 1
Target Texturs None (Render Texture] ®
Occlusion Culing -
HOR Use Graphics Settings
MSAA Use Graphics Settings
Allom ynamic Resolution
Steieo Separation 0022
Stereo Convergence 10
Target Eye Both
1 Auio Listensr CEN
‘Add Component

MEeTaKIVAOTE, KALLOKWOTE KoL TteplotpéPte Tov AoTpovalTtn £T0L WOTE va
Bploketal og KaAr B€on UMPOOTA ATO TNV KAUEPQA.
B e osus + dimpaproject.el

hitp://www.asceps.org
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NPOzOHKH Twpa TTOU N GUCKEUN avarmapaywyng Kat n KApUeEpo cuyxwvelovtal, BEAOUE VA UITOPOUUE
DO I THN Vo GELXOULE QVTIKEIEVA.
KAMEPA

Emteldn v BENoupE QUTO TO CEULVAPLO VA lval TTOAU PeyAlo Kal
B£Aou e va anodpuyoupe TV Kwdilkomoinon akoAouBlwy, Ba oag
Seifoupe povo nwg va Seifete pwg ota oTOLXEL KaL VO UnV T
ETUAEEOU UE TIPOG TO TIAPOV.

Av oag evOLadEPEL va ETIAEEETE KAL VOL EVEPYOTIOLNOETE OTOLXELQ, plETE
MLo potid oto mpoBepa GvrReticlePointer kal to GvrEventSystem mou
SlatiBevral oto Makéto Google VR

2toweila -> Google VR-> Prefabs -> Cardboard -> GvrRetcilePointer

Kal oUpeté to otnv KUpLA KAUEPQ

Mo va pooBoete éva dweg otnv amoYPn oog (N KAUEPA GOG OTN CUOKEUN
OVATIOPAYWYNG) KAVETE KALK S£ELA OTNV KAWEPA OTN OKNVI 0ag Kol eTUAEETE
LIGHT.

[ GCB - SampleScene - PC, Mac & Linux Standalone - Unity 2019.3.15f1 Personal* <DX11>
File Edit Assets GameObject Component GoogleVR Window Help

© Inspector

ve vSOmpllScoM' : £} ¥ MainCamera
@ GvrEditorEmulator Tag MainCamera

¥ W v Camera

Clear Flags
Duplicate Background
Delete Culling Mask
Select Children
FOV Axis
Create Empty Field of View
30 0tject 2 Physical Camera
2D Ovject >
Effects > Clipping Planes
Light 3 Directional Light
Audio > FPointLight Viewport Rect
Video > Spotlight
e Project ul > Avea Light
$ Camera Reflection Probe ~ ::"" v Pt
v Favorites T Light Probe Group nderi
O, All Materials Target Texture
O, All Models Occlusion Culling
O, All Prefabs HOR
MSAA
t:“',im"'!“' Allow Dynamic Resolutiod
Target Display
Target Eye
11 v AudioListener

P Taper ici pour rechercher

J€ 0UTO TO ogpLvApLo eTiAéEape To SPOTLIGHT kal pumopeite eniong va
OAAAEETE TO XpWUA TN aKTivag eav To embupeite otnv kKaptéAa INSPECTOR

- Erasmus+ dimpaproject.eu
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@ v Spot Light
b4 Tag Untagged

A Reaitime indire<t bou

Shadow Type
Cookie
s Project. Draw Halo
e Fiare
R ;-::mm Assets > Render Mode
aterials.
O, All Models Culling Mask
©, All Prefabs.
RGB 0-255+
G e—

A

P Taper ici pour rechercher

naz NA
XPQMATE, 1. Anpoupynote éva pakelo oTo oTolxelo oag e To ovopa YAIKA (vta nap adeypa)
BAGETE MIA -VC-(E‘S«'WFES“-ENK ‘\A:(E\\vmsumok/
) E 3 [T ]
SYSTASH'H o - , T
EIZAFQrH .8
EIKONAZ ZE B o
ANTIKEIMENO FEe -

NAIXNIAIOY

TexMesnire
Scene

Fuid v
Copy Pomn Aterec  Aado Moer
adi Materat
Lens Flave
. Render Texure
import New Aset. Ughemap Paracoeters
Import Pckage * Custom Render Teure
Eaport Faca
e Soree Atss
+- Spries.
v & Favorites [ SuectDopenconcies
L Al Mateials B o Ao Contoter
S Reimgon A
Al Prefats Avvmator Overde Consroer
Reimport Al At Mask
v Assers. e
v @ Craracters o e Timeine
un AP U Sgnat
- patorats
o Plarets Undate UlEiemerss Schema Py Materst
W SPACE SHP Open C# froject Pryscs Moterial 20
e L,
Soopex Custom fot
+ i Packages | Ubiements.
W Assets/Characters Pianets
tegcy

R Taper ici pour rechercher

2. Click right -> CREATE -> MATERIAL
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3. Xpwpotiote To otnVv kaptéha INSPECTOR

e T T S o e
e PanetMatenaisMateraisGronamat

4. YUpEeTE TO OTO AVIIKEIPEVO TOU Ttavidlou oag

< [ o Fersonal* <DXI1>
File Edit Assets GameObject Component GoogleVR Window Help

AA\N erhoyn v BEAETE val £XETE TO AVTIKELLEVO TOU TAXVISLOU OOC LE LA ELKOVOL:

Mpaypatonotote APn tng elkovag oto otolxeio oag (EIZAFQrH NEOY
MEPIOYZIAZ kol ELOQyAyETE TNV EIKOVA O€ png.)

Mo aUTO TO £pYO KOTEBACALE TNV MAPAKATW EKOVAL:

"Awpedv uPnAng avaiuong pwrtoypadia appou, AALOU, nAlakol ¢pwTaog,
uon, damedo, xwpog, KUKAoC, emipavela, mAavitng, Appoditn, nAlako
ocuotnua'" ->

- BeBawwBeite 6tL n popdn kat o peyebog eival katdAAnAa yia to )
Erasmus+ | avukeipevo kat ug Aettoupyiec3D. dlmpaprOJect.e||1
.50
WAKETH <ol cospmoms @ LEs APPRIMEURS 2o, [E1Sd

The #DIMPAproject has been funded with support from the European Commission. Its content and material reflect the views only of the authors, and the Commission cannot be
held responsible for any use which may be made of the information contained therein. Project code: 2018-1-FR01-KA202-048220



https://pxhere.com/en/photo/1262003

#DIMPAproject

MIPA proect

Digital Innovative Media Publishing for All

JUPETE TNV ELKOVA OTO QVTIKEIHEVO TTaLXVLSLOU.

NPOzOHKH 161a Sladikaoia pe tov Aotpovalth, Ba eL00yAYOULE APKETOUC MAAVNTEG Kall
AANNQN otolxeia Tou HALakoU ZuoTUATOG 0T OKNVI| MOG YL VA TO KAVOULLE TTILO
ITOIXEIQN nayvidlapiko.Exouv AngpBOet 6Aot oL mtopot oto POLY.GOOGLE

Mo aUTO TO £PYO €XOUME KATEBACEL LEPLKOUG TTAAVATEG altO TO HALaKO
ZUoTNUA KoL OpLOEVA oToLKEla yla Tov AoTpovauTn pag (éva dtactnudmAolo
Ko éva yavtlo)

'O)Ao 1o avtikeipevo Tou mayvidlou pnopei va 6et oto SCENE TAB

~ Layer Defaut

D
X -0.2815364 ¥ 20430422 02637215

X 4.508 ¥ 532404 12,7448

X 30432 Y3043 230432

Add Companent

FR 0 taper i pour rechercher

Z€ QUTHV TN OKNVH €XOULE TIPOCBECEL oToLXELD OTIWG
- TAQWVNTEG TOU NALOKOU GUOTHATOG
- Eva AIA2THMOIAOIO
- évag aotpovalTtng
- éva Buopa
(6Aa SLaBéoua oto Poly pe adela CC-BY)

AnoBnkelote TNy Otav oAokAnpwOeL N okNVA 00¢ Kal EXETE MPOOOEDEL O, TL BDENETE, TIPEMEL VAL
oKnvA oog Vv anobnkevoete

Apyxelo -> AnoBrikeuon wg -> LYMBOYAEZ: anoBnkeVote 10 oto dpdkeAo Unity.
Ovopdoope to £pyo SSScene (SolarSystemScene) kot propeite va to Bpeite
oto ¢pakelo ASSET oto PROJECT TAB

- Erasmus+ dimpaproject.eu
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B3 GCB - SSScene - Android - Unity 2019.3.15f1 Personal <DX11>
File Edit Assets GameObject Component GoogleVR Window Help
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Assets > Scenes

@ Assets/Scenes/SSScene.unity
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[l GCB - SSScene - Android - Unity 2019.3.15f1 Personal* <DX11>
File| Edit Assets GameObject Component GoogleVR Window Help

New Scene Crri+N
Open Scene Crle0
Save Curl+S
Save As... CrleShifteS
New Project...

Open Project...

Save Project

Build Settings... Ctri+Shift+8

Build And Run

¥ Favorites Assets >

Q, All Models
o kW

v G Characters Characters  Colors  GoogleVR

¥ W ackages s Assets/Characters/Planets/Materials e
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Ac ptid€oupe Ma va dnuloupynoete tn oknvn oag: File -> Build
v epappoyn Settings

- GCB - SS5cene - Android - Unity 2019.3.15f1 Personal <DX11>

Edit Assers GameObject Component GoogleVR Window Help
INew Scene (RN
Open Scene s
Save culss

Ctrlashiftes

R Taper ici pour rechercher

Ko, otn ouvéyela, oupete t oknvh oag otig EKHNEZ KATAZKEYHS Kot KAVTE K]
ermuhoyr) KATAZKEYH KAI EKTEAEZH

[ GCB - SSScene - Android - Unity 2019.3.1511 Personal <DX11> Build Settings ]
File Edit Assets GameObject Component GoogleVR Window Help

\lk oTnV

I

R Taper ici pour rechercher

- Erasmus+

ﬂAlSmETH LR

T Berufsirdurungsinstnd OO
OF THESSALY

cepsproecessecs @) LES APPRIMEURS

‘LogoPsyCom,

The #DIMPAproject has been funded with support from the European Commission. Its content and material reflect the views only of the authors, and the Commission cannot be
held responsible for any use which may be made of the information contained therein. Project code: 2018-1-FR01-KA202-048220




#DIMPAproject

M Aprojeﬁ

Digital Int ve Media Publishing for All

PYOMIZTE TO Mpwv e€aydyete To apxeio oag, mpenel va pubpuioste to ThAédwvo oag.
KINHTO 3A3
Ma va urmopeite va ekteAéaete TNV epappoyr oto ThAédpwvo oag Android, Ba
TIPETIEL VAL EVEPYOTIOLNOETE TI¢ EMAoy£g mpoypappatiot, dnAadn:
- avoifte Tnv 006vn Pubuiocelg,
- KAVTE KUALON TTPOG TOL KATW KOl TLATHOTE IXETIKA LE TO ThAEPwvo 1
IXETIKA JLE TO tablet.
- MetakwnOeite mpog Ta KATW 0To KATW HEPOG TG 006vn¢ NMAnpodopicsg
Ko Bpeite to Build
Oa 1o eudavicel kat Ba pnmopeite va To eMAEEETE OTIG pUBULOELG TOU TNAEDWVOU
oog
YTn ouvéyela, Kavte KALk oto DEVELOPER MODE kat emtp€Pte TNV €midoyn
USB DEBUGGING
Yuvdéate to TNAEDWVO 0a¢ OTOV UTTIOAOYLOTH 00 Kal eTtp€PTe Tn cuvbeon Ue
TLC CUOKEUEG PUMOUAKNONG.
To tNAédpwvo oo eival Twpa £tolpo va AdPel éva apyeio .apk (aitnon)
NPAZTE THN Erotpedte oto UNITY kat cuvdéote to tnAédpwvo Android oto dopntd

E®DAPMOTH unoAoyLotr oag. H cuokeun oag Ba epdaviotel otnv evotnta RUN DEVICE.
ITH ZYZIKEYH EruAé€re To KoL kavte KALK oto BUILD AND RUN
IAZ Oa npénel va anobnkevoete to dvopa tou apk. Apxeio kot Ba ekteAeital

outopata oto tnAépwvod coc.

Twpa MPENEL anAwG va EEKLVNOETE TNV epapuoyn Kal va anoAavoete!
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| - GEEEE CEEEE
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KukAodopia

MoU dnuocteloarte To epyaleio; | H epappoyn pmopel va AndOei povo oe Android Smart
tNAEPwVo Kol va EKTEAEDTEL LE aKOUOTIKA Google
Cardboard.
H avantuén evog épyou os VR amoattei va yvwpilou e Kal va
ETUAEEOU UE EK TWV TTPOTEPWV TIOV Ba elval opato To £pyo.
Moty Y& auTO To otadlo, To Android + Google Cardboard sival ot
EUKOAOTEPOL, OL TILO EVEALKTOL Kal oL pBnvoTEPOL TPOTIOL
EUPAVIONG ELKOVLKNG TIPOYHATIKOTNTAG

Avtiuetwrnioats To yeyovog OTL KABE TpOypapLLa TIPETEL VAL AVaTTUXOEl
Sduaokoliec o auto to oUudwva e to TeAko péoo: i0S, Occulus, GoogleCard board
BrAuo; kaBlota §UckoAn tn Snuloupyia evog eUKOAA KOl O LEYAAO

Babuo npooPaocipou epyaleiou. Auotuywe, to i0S
napapével o SUokoAo va aloBavOel Aveta Ue Toug
Av val e€nynote omoudaioug apxapLoug

6. [MEePLEKTIKA TPOOEYYLON

Mola evépyela ebapUOOATE YLO VO KOTOOTHOETE TO EpYAAEio 0€ 0G0 TO SUVATOV MEPLOCOTEPOUC XPHOTEC;
Auvotuywg, to VR eival € oplopol Alyo amoKAELOTIKO, TPAYUATL, KAOE MPOYPAUUA TIPETEL VA
avantuxBel ylao £va cUYKeKpLUEVO HECO ) aKOUOTIKA VR.

JTNV MePIMTWoN Hag, TO LOVTEAO pag Ba £TPETE va €lval TILO TTEPLEKTLKO KOL VOL TIPOTEIVEL yLa
napddslypa avamtuén yia i0S, aAld auto Oa sixe petatpePet TNV epyocia og oAU TLo
TeplmAokn Kol pokpUTEPN.

7. Kaléc / KOKEC MPOKTIKEC

Oa ouvictouoate auto to | Nat
AOYLOLKO OTOUG XPIOTEC;
MapakaAw eEnynote Mpwtov, elvat éva Swpedv AoYLoULKO Ttou cuve)ilel va
EVNUEPWVETAL KaL va BeATioTomnoleltal.

AgUtepov, mpoadépel MOAAEG SuvaToTnTEG, amd anoyn
YPOPLKWV KAl AELTOUPYLWV

Mota npdtacn Ba dwoate o AToUA TTOU SnULoUPYOUV Eval TETOLO epyalAeio i Snuloupyouv
TEPLEXOLEVO OE€ QUTHV TNV TEXVOAOYLQ;

MapoAo mou ival Alyo eplmAoko Kal To TUAHA KwSLKomoinong anéxet oAU ano 1o va

elvat amo, untdpyxouv MOAAQ oepvapla kal ypadeio BorBelag mou pnopouv va

urnootnpifouv Tov xpnotn otn dnuloupyla TG OKNVAG TOUG

QoT000, elval ONUAVTIKO Vo EXETE KOTA VOU OTL €va TETOLO AOYLOUIKO OUTALTEL TPAKTLKNA KoL XpOVo
MAVQOELOTIQLACETE OTO EMAKPO. dimpaproject.eu
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